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Department	of	Chemistry	
Website	Editing	Instructions	

	
I.	Introduction	

The Communications and Web team have overall responsibility for all content on the department 
web pages.  As part of this remit, we provide training for department members who manage the 
content of particular website sections. We use the Drupal content management system for our 
web pages and adhere to the overall look and feel of the University of Cambridge Project Light 
template. 

The department website is composed of many ‘microsites’ which can all be individually edited.  
Examples include the Library, Human Resources and Teaching microsites. We provide training for 
all microsites, including Research Group pages which use the department template (see, eg, the 
Vignolini Research Group microsite). Some research groups choose to create and run their own 
websites. We cannot offer training for sites such as these, which are not hosted by the 
department. 

If you ever have any questions about departmental website content, or would like to request a new 
feature or website section, please contact one of us in the first instance.  If we can’t deal with your 
request, we can direct you to the correct channel.   

The Communications and Web Team: 

• Diane Harris, Project Delivery Manager:  dh473@cam.ac.uk 
• Rachel Gardner, Chem@Cam editor: rg580@cam.ac.uk 
• Carl Hogsden, IT developer: cdh30@cam.ac.uk 

Questions relating to purely technical issues (eg, My computer won’t start! My email doesn’t work!) 
should always be directed to support@ch.cam.ac.uk. 
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II.	Writing	for	the	web	

Although this training is primarily about how to edit web pages using the Drupal content 
management system, it is also important to remember that writing for the web is different from 
other types of writing.  Here are a few simple guidelines to follow when working on your website: 

• Keep sentences short. 
• Use bullet points (like this!). 
• Divide your content into short paragraphs separated by subheadings. 
• Insert links into the content, don’t add them separately (you will be taught how to do this).  
• Use the active voice. 

 
Example: 
The event is free, but please register to help us determine numbers. 
NOT 
The event is free, but attendees are requested to register so that numbers can be determined, by 
clicking on www.website.address.ch.cam.ac.  
 
Example:   
You can find further information about my research on my staff page. 
NOT 
Further information about the research I am involved in can be found by visiting my staff page. 

We recommend that you use the University style guide for consistency. 
(http://www.cam.ac.uk/brand-resources/guidelines/editorial-style-guide) 
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III.	Accessing	the	edit	menu	

1. Click the Login tab on the top right of the page between the University menu strip and the 
Department of Chemistry navigation bar. 

 

2. Just above the main content page you will see these tabs: View, Edit, Revisions, Track, 
Nodequeue (not all of these tabs may be visible to you, depending on your site). You will use 
these tabs to edit that page (see “Editing an existing page”, page 7).  

 

3. At the very top left of the window, you will see a further menu with these headings:  Site admin, 
dashboard, content, manage content, add content, find content, manage blocks. You will 
use these tabs to create new pages, set-up quick links or contact details and organise the 
structure of the site (see “Creating new types of pages”, page 18, and “Managing the site 
structure”, page 22). 

Important:	Always	save	your	work!	

4. As soon as you have created some work you must remember to save it. You can find the Save 
button at the bottom of the page below Publishing Options. If you navigate away from the page 



Department	of	Chemistry	
Website	Editing	Instructions	

September	2018	
	

 6 

before clicking Save, your changes will be lost.  Be careful: clicking Delete will delete the entire 
page and deleted pages cannot be recovered! 
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IV.	Adding	content	to	an	existing	page	
 
1.		Introduction	

A.	Edit	tab	

Click the Edit tab located at the top of the content window to open the page in edit mode. Here 
you can edit various fields (not all pages will have all fields). 

B.	Main	points	on	the	page	

• Editing Instructions: a link to the editing notes  
• Title: where you can edit the page title  
• Leading Image: the image which will appear at the top of the page 
• Body (Edit summary): where you can edit the first paragraph and the main body of text 
• Related links: where you can add links, e.g. to a researcher’s group or college 
• Menu settings: where you can edit the menu link title, description, parent item, weight) 
• Publishing options: where you can publish or unpublish pages 
• Publications: (research group pages only) 

2.	Adding	text	

A.	Body	(Edit	summary)	

Enter text in the window titled Body (Edit summary). Note: If you click on Edit summary, the title 
will change to Summary (Hide summary). This summary is used when creating Teasers (see 
page 18). For now, make sure you are working in the window with the title Body (Edit Summary). 

 

B.	Edit	icons	
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Use the edit tools displayed in icons across the top of the page editor. Many icons look and 
function the way they do in Word. These allow you to format text on the page. Hover your cursor 
over an icon to see its pop-up description.  

 
 

C.	Cutting	and	pasting	text	
 
You can type directly into the content area, or you can cut and paste content from other sources, 
such as Word or another web page. Note, sometimes existing documents have hidden formatting, 
which may affect the way your text appears on the website. To avoid this, you can use the 
‘clipboard’ icons (the one that says paste as plain text) in the top row to paste from Word or to 
paste as ‘plain text’ i.e. without formatting. If you know HTML, and want to use it to edit the text 
formatting, click the “Source” button to access the HTML coding. 

D.	Using	the	format	icon	
 
By default, text displays in the pre-set normal font style. With the Format selection box, you can 
change text to other pre-set styles. It is recommended you use the pre-set styles to maintain 
consistency throughout the webpages. Try the different headings, save your work, and see how 
they look (they look different in the final view). The Address format spaces the lines more closely, 
as in a street address.  Experiment with the other heading formats. 
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3.		Adding	links	

All webpage links consist of some text, which the user will click on, and a target, which is the 
webpage or email address the user will be taken to when they click on the text. Highlight the text 
for the link, and then click the Link icon.  

 

After you have clicked on the link icon, a window will pop up. There are then a number of different 
types of link you can create. 

A. Links to other pages on my site 
B. Links to external websites 
C. Links to email addresses 
D. Links within a page (anchor links) 
E. Links to uploaded files 

A.	Links	to	other	pages	on	my	site	

1) For Link Type choose Internal path.  
2) Start typing the title of the page you would like to link in the Link field. A list of page 

titles matching the text that you type will automatically appear; click on the page you want.  
3) Click OK.  
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 B.	Links	to	external	websites	

If you are editing a department microsite, the main Department of Chemistry website is considered 
an external website. You can also link to other web pages. Under Link Type choose URL, and 
then enter the full address of the website you would like to link to in the URL box. Ordinarily, you 
will not need to change the Protocol option. 

 

C.	Links	to	email	addresses	

Change the Link Type to E-mail and enter the desired email address in the E-Mail Address box. 
You can optionally specify a Message Subject and Message Body, which will automatically be 
set as the default email subject and/or content in the user's email program. It is good practice to 
include the full email address on the webpage, as not all users can utilise the email link function. 
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D.	Links	within	a	page	(anchor	links)	

It is possible to link to another part of the same page, useful in long documents. This sort of link is 
called an anchor. In the following example, we will create an anchor at the text Subsection 
heading, which a user will be taken to when they clink on the link Lorem ipsum.  

1) First create the anchor:  Highlight the desired text (Subsection heading, in this example) and 
then click Anchor. 

 

2) You will be asked to specify a title; this can be anything you wish but it is best if you choose a 
meaningful name. In this example, we have set the title to subsection. Select OK. 

3) Highlight the text you would like to convert to a link (Lorem ipsum) and click the Link icon. 
Under Link Type, choose Link to anchor in the text. Select the anchor name you specified in the 
previous step in the By Anchor Name drop-down list. Select OK.  
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E.	Links	to	uploaded	files	

1) Highlight selected text. 
2) Click on the Link icon.  
3) Change the Link type to URL.  
4) Click Browse server.  You will be taken to the web server for your site, which shows all 

files that have been uploaded. (To upload a file, see “Uploading files to link to text”, page 
13).  

5) Browse to the location of the uploaded file, and double-click the file. This closes the file 
manager display and returns you to the Link dialog box, with the URL of the uploaded file 
inserted into the URL box.  

6) Click OK to create the link. 
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4.	Uploading	files	to	link	to	text	

 

Documents must be in Word, Excel, PowerPoint or .pdf. They may be no larger than 2Mb. 

1) Highlight text that will be linked. 
2) Click the link icon. 

 

3) In the dialog box select the Link type URL.  
4) Click Browse Server - you will be taken to the web server for your site, which shows all files 

that have been uploaded. 
5) In the menu bar choose Upload files (floppy disk icon, green + sign). 

 

6) Select Browse, navigate to and select your file (or files), click OK.  
7) The file is uploaded onto the web server for your microsite. Double click on the file. 
8) You are now returned to the file browser screen, where your document has been added.   
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9) Double click on your document, a dialog box will appear with the new URL for your file.  Click 
OK. 

10)  Your highlighted text will now appear blue and underlined.  
11)  Save the page. Click on your new link to check that it is functioning correctly.   

a. Documents in Word, Excel and PowerPoint will be downloaded.  
b. Documents in .pdf format will be visible in a new window.  

5.		Adding	inline	images		

Inline images are pictures, diagrams or graphics that appear in the content area.  

1) Position cursor where you wish to position your image within the text. 
2) Click the landscape icon. 

 

3) You see a new screen with three tabs: Image Info, Link, Advanced. 
4) Select Image Info.  
5) Select Browse Server.  
6) You are taken to your site’s web server which displays files already uploaded to your site.  
7) Choose Upload files in the menu bar (floppy disc with + icon). 
8) Select the file (or files) from your computer that you wish to upload.  
9) Double click on the image that has been uploaded to your web server.  
10)  You are returned to the three-tabbed dialogue box with the image in place. Adjust the width 

and height (see “Image definitions and recommended sizes”, page 27). 
11)  Use the HSpace and VSpace buttons to create a margin around the image, so that the text 

doesn’t run into it. In general, these should be set to ‘10’ but you can experiment with these.   
12)  You do not normally need a border, but again you can experiment. 
13)  Alignment may be left, right, or not set (in which case the image will be placed centrally. 
14)  Click OK. 
15)  Your image will appear in the content area. Note that it will not always appear in the final 

view as it does when editing, so some trial and error may be required.  
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V.	Editing	other	elements	of	a	basic	page	
1.	Related	links	

A. The related links feature is located below the text window. Add your desired title and type or 
copy and paste the web address in the URL window. Click Save. Check link in View.   

 

B. You can add further items by choosing Add another item. Related Links will display in the 
right-hand sidebar on the page, as illustrated below. 

 

2.	Publishing	options	
 
Sometimes you may be working on a page but it is not in final form. You can unpublish your page 
so that it still exists but it cannot be viewed by the general public.  

1) Select Publishing options (at the bottom of the page).  
2) The Published field is ticked. Click to untick.   
3) Click save.  
4) Your page is now unpublished. It has a light pink background, to remind you that it is 

unpublished. 
5) When ready to publish, go back to Publishing options and tick Published. 
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3.	Title	
 
Enter the Title of your page in this field.  It is important to ensure this title is consistent with the title 
you use in the menu (see “Manage main menu and tabs”, page 22).  
 
4.	Teaser	link	
	
See “Teasers”, page 19. 
 
5.	Menu	link	title	
	
This is the title that will appear in the main menu of your site. It is important to ensure this title is 
consistent with the page title.   
 
6.	Parent	item	
 
Click the drop down menu to select the Parent Item, which your page will appear under in the 
main menu of your site.  If your page is a top level menu item, leave it as <Main menu>. 

7.	Weight	

Weight controls the position of the menu link in the menu list, relative to its parent item. This can 
also be controlled by managing the menu structure. (See “Manage main menu and tabs”, page 
22).  

Always	SAVE	your	edits.	Click	Cancel	if	you	don’t	want	to	save	(or	navigate	away	from	the	
page	without	saving).	Clicking	Delete	will	delete	the	entire	page.		Deleted	pages	cannot	
be	recovered!		
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VI.	Creating	new	types	of	pages	

1.	Creating	a	new	page	(general)	 	

 

1) In the top left corner of the screen, click Add content.   
2) A new window will appear with a selection, in alphabetical order, of content/page types 

such as: 

• Basic page 
• Carousel page 
• External staff page 
• Research page 
• Staff page 

3) Choose the appropriate page and work on it as required. Always remember to SAVE.  

2.	Home	page	set-up	
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A.	Carousel	images	

1. To create Carousel images on your home page 

1) Click add content at the top-left corner of the page.  
2) Select Carousel items.  
3) You will see a page called Create Carousel Items.  
4) Enter a title, which will appear at the bottom of the image (see www.cam.ac.uk for an 

example). 
5) Upload the image you would like to use. The image must be exactly 885x432 pixels (See 

“Image definitions and recommended sizes”, page 24).  
6) You may enter a website address in the Link field, which will take you to that site when the 

image is clicked on.  
7) Click Save. 
8) If you only create one Carousel Item, it will appear as a static image on the home page. If 

you create multiple items, they will appear as a slideshow. 

2. To change the order of Carousel items or delete a Carousel item 

1) Click on site admin. 
2) Select Configure front page slideshow. 
3) You may drag and drop or delete pages. 
4) Remember to Save.  

B.	Teasers	

Home pages have been set-up with the Teaser feature. If you want to add teasers to other pages 
please see Section IAdvanced Editing Skills, s. A teaser must have a corresponding page with a 
leading image.  

1. To add a teaser of an existing page to the homepage: 

1) Make sure you know the title of the page you want to ‘tease”. On your existing page, you 
may add lines in the Summary field, which will appear in the teaser. If you do not add a 
summary, a trimmed portion of the full text will appear in the teaser. 

2) Click on Site admin in the top left hand corner of your page. 
3) Select Configure Chemistry Nodequeue views 
4) Choose the number of columns (eg how many teasers you wish to appear) and whether the 

teaser will appear in vertical or horizontal format. Experiment with the layout as you wish. 
5) Select View nodequeue Front page teasers 
6) Start typing the title of your page in the field labelled enter the title of node to add it to the 

queue. 
7) The full title of your page should appear; select it and click Add content. 
8) Your page will be added to the list. Drag and drop to adjust its position. 
9) Click save.  

2. To add a teaser image and a link to an external page:  

1) Create a basic page. 
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2) Upload your image to the basic page. 
3) Give the page a Title. 
4) Click Edit summary. Enter a very brief summary.  This is what will appear next to the 

Teaser on the home page.  
5) Scroll down past the body to Teaser Link. 
6) Enter the Title.  (This is what will appear in the black box next to or under the Teaser, 

generally “read more.”) 
7) Enter the URL of the page you wish to be linked as a Teaser. 
8) Save. 
9) Follow the instructions “To add a teaser to the homepage.” 

You do not have to make new images for Teasers. These thumbnails are scaled down versions of 
the leading image in the page you are teasing and render at 250x125px. 

3. To change the order of teasers: 

1) Go to Site admin. 
2) Choose Configure Chemistry Nodequeue views. 
3) Choose View Nodequeue. 
4) Change the order by dragging and dropping, and Save.  

C.	Quick	Links		

Quick links appear in the right hand column after Related links (if any) and their format differs 
slightly.   

1) Click on Site admin. 
2) Select Site settings. 
3) Select Links to configurable settings. 
4) Select Quick links. 
5) Add name of your link and URL. 
6) Save. 
7) To change order of Quick Links, drag and drop to desired order. 
8) Remember to save. 
9) To change the title of a Quick Link, click on the title in this mode to get the edit title 

instruction. Click edit title. Save.  
10) To edit the Quick Link, click on configure item.  
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D. To add contact details 

1) Select Site admin. 
2) Select Site contacts. 
3) Enter correct contact details.  
4) Submit. 
5) The contact details will appear in the bottom right footer (footer number 4). 

E. To add other content to a right-hand sidebar. 
 
See advanced editing skills on page 27.  
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VII.	Managing	the	site	structure	

						 	

1.	Find	content	

1) Click on Find content in the top left corner of your screen. 
2) You may filter the item by status (published or not published) and by type (basic page, 

carousel, etc). Select Filter. 
3) You may also enter the full title or key word of the title in the field Search by Title. 
4) Select the content, and choose to edit or delete.  

2.	Delete	content	

Most pages have a delete option at the bottom.  This action cannot be reversed.  Another way to 
delete content is to: 

1) Find the content, per the above instructions. 
2) Select the content, and choose delete. 

You may also choose more than one page to delete and delete all simultaneously.  

1) Find the content, per the above instructions. 
2) Tick all the pages you wish to delete. 
3) In the Update Options field, select delete selected content from the dropdown box. 
4) Select Update. 
5) This action cannot be undone. 

3.	Manage	main	menu	and	tabs	

You can find the main menu to manage in various ways: 

1) Click on Manage content. 
2) You will see the Main menu window.  
3) You can drag and drop the menu items into the desired places. Move the item to the right to 

make it a subheading. (Only parent headings and their children are visible on the home page – 
no ‘grandchildren’ (ie, sub-sub headings). 

4) You can also add a New menu item (at the bottom of the page): 
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a. Type in the new menu item title. 
b. Select Save. 
c. This takes you to a new page. Enter the desired title in the Menu Link Title field. 
d. In the Path field, add a URL for a link, or start typing the name of an existing page within 

the microsite and the correct page will be prompted.  

5) Always remember to Save your changes.  

	

	

OR	

1) Go to Structure. 
2) Choose Menus. 
3) Choose Main Menu. 
4) Follow the above instructions. 
5) Save.  

	

In	Manage	Content	–	delete	item,	do	not	delete	the	page!	
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VIII.	Image	definitions	and	recommended	sizes	

The Photography and Reprographics Department provides Web-ready photos for the department 
web pages in the three sizes discussed below. Existing photos are usually made available to view 
on onedrive.   

Please contact Photography and Reprographics at photography@ch.cam.ac.uk for further 
information about photos.  

If you would like to obtain software so you can re-size and crop images on your own computer, 
contact support@ch.cam.ac.uk. 

1.					Carousel	Image:	885x432	pixels	

 

1) The Carousel is generally only used on the home page and must be exactly 885x432 pixels in 
size.  

2) Carousel images may be used as leading images on other pages; the system will scale or crop 
them. The result will depend on the image content; important areas may be lost in the process, 
rendering the image aesthetically unattractive or incomprehensible in the case of graphics or 
diagrams. You must check the final image to ensure that it has been scaled appropriately.  
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2.	Leading	Image	1:	885x288	pixels	

 

1) Leading image 1 should be used when there is no right hand side bar (eg, no related links or 
quick links).  

2) If a sidebar is added the image will be automatically scaled down to 590x288 pixels. You must 
check the image for correct scaling. 

3) It is always better to upload the correct-sized image.  

C.	Leading	image	2:	590x288	pixels		

1) This image size is designed to work if the right hand side bar is being used for related links, 
quick links, twitter feed etc.  

2) If you use a Carousel image or Leading image 1 the system will scale down to 590x288. The 
aspect ratio of a carousel image would be correct and the picture should display correctly. 

 

	

	

4.	Inline	images	
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These can be varied in size but it is recommended that you use one of the standard image sizes. 
Smaller file sizes upload more quickly. Maximum size is 2Mb.  See “Adding inline images”, page 
15, for instructions. 
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IX.	Advanced	editing	Skills	
 
You must create and manage blocks in order to create certain sections. These include creating or 
adding content other than quick links or related links to a right hand sidebar, and creating node 
queues, such as teaser pages. This use of Drupal is slightly more advanced, and you can ask the 
Web and Communication team to create these setups for you if you prefer. 
 
1.	Create	a	block	
 
1) Go to Manage Blocks (menu option in grey menu bar at top of page). 
2) Select + Add block. 
3) Give the new block a Block title and Block description (which will appear on the blocks 
administration page).   
4) You must enter content in the Block body. You may upload a logo, or add the embed code for 
a Twitter feed or a video, for example. 
4) Scroll to the bottom of the page and select Save Block. 
 
2.	Create	or	add	content	to	a	right	sidebar	(other	than	quick	links	or	related	links)		
 
Most microsites are set up without a right hand sidebar. If you add quick links (page 20) or related 
links (page 16), then the right hand sidebar will automatically appear.  However, sometimes you 
may wish to add content other than quick or related links, such as a Twitter feed or a logo, to a 
right hand sidebar. To get content into the right side bar you need to create a block and assign it to 
the sidebar region. You can either do this all in one block, or create several blocks. 
 
1) Follow the steps above to create a block. 
2) Go to Manage Blocks. Find the name of your new block listed under Disabled in the Manage 
Blocks page. 
3) Go to the drop-down menu to the right of your block title and select Sidebar, which will transfer 
the new block to the Sidebar region. 
4) Select Save Blocks (bottom of the page). 
5) By default, your block should now appear in the sidebar on every page. You may limit the pages 
on which the block appears (eg, you may only want it to appear on the home page or on a 
selected page).  
6)To select where the block will appear: 

• Go to Manage Blocks. 
• Find your block and select Configure. 
• Go to Show block on specific pages. 
• Choose one of the options (“All pages except those listed” OR “Only the listed pages”). 
• Enter the page links into the text box that you wish to exclude/include.   

o Enter just the page name for the URL (eg, for http://www-
jones.ch.private.cam.ac.uk/research, you would enter research, for http://www-
jones.ch.private.cam.ac.uk/latest-news enter latest-news.) 

o To exclude or include child pages under a parent url, enter parent/*. 
• Save block. 
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3.	Create	a	new	teaser	page	
 
Home pages are already set up with the capacity to create teasers, and you simply have to create 
the teaser pages (see page 16). However, you may wish to set up a new page of teasers (see, for 
example, the “Current news items” page on the department website). To create a new page of 
teasers, you will need to take the following steps: 
 
A. Create a node queue 
B. Assign the node queue to a block and configure the block 
C. Configure the way the node queue will look 
D. Add “nodes” (existing pages) to the queue.  
 
We take you through each of these steps below. 
 
A.	Create	a	node	queue:	
1) Go to Site admin (top left corner).  
2) Select Add a new nodequeue.  

• For some pages you might have to go to Site Admin, then select Site Settings, then 
select Nodequeues under “Links to configurable settings”, then select + add simple 
queue. 

3) Give the page a title (eg, if you are creating a node queue of teasers for your research group’s 
different research areas, you might call it Research Group Interests) 
4) Scroll down to Types and select Basic page. 
5) Select Submit to save. 
 
B.	Assign	your	new	node	queue	to	a	block and	configure	the	block: 
1) Go to Manage Blocks. 
2) Find your new node queue under the Disabled Section.  
3) In the drop down menu to the right of your node queue, select Content. 
4) Select Save blocks. 
5) Now your node queue should have moved to the Content region of the Manage Blocks page. 
6) Go to Manage Blocks, find your node queue and select Configure. 
7) Select your desired visibility settings by  choosing one of the options (“All pages except those 
listed” OR “Only the listed pages”). 

• Enter the page links into the text box that you wish to exclude/include. Generally this will 
only be on the home page of your microsite, or one particular page (eg, Research News 
or Research Interests).  Note: this page must already exist as a basic page, and you 
must know the link. 

• Enter just the page name for the URL (eg, for http://www-
jones.ch.private.cam.ac.uk/research, you would enter research, for http://www-
jones.ch.private.cam.ac.uk/latest-news enter latest-news.) 

• To exclude or include child pages under a parent url, enter parent/*. 
• Save block. 

 
C.	Configure	the	way	the	node	queue	will	look:	
1) Now you need to configure your node queue.  Go to Site admin, find the name of your node 
queue, and select Configure. 
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2) You may now choose to have your nodes appear vertically or horizontally, and you can choose 
how many columns will appear. Look at other microsites for examples (eg, the home page of the 
department website has 9 vertical teaser nodes arranged in three columns. The Research Interest 
Group pages have five horizontal teaser nodes arranged in one column.) 
D.	Add	nodes	to	the	node	queue.		
1) Select Site Admin, Configure Chemistry Node Queue Views. 
2) Find your node queue and select View Node queue. 
3) The node queue is empty and you must add nodes. 
4) If the page you wish to add is a page that already exists within your website, you can simply 
start typing its name, and it will appear. Click add content and Save. 
5) If the page exists in a different website, you will have to create a new basic page with an image, 
a summary, and a ‘teaser link’ to the page you wish to tease (see creating Teasers at page 19). 
 

4.	Embed	a	video	

1)  Upload the video to the department YouTube channel at 
https://www.youtube.com/channel/UC3Jf5CxTQD5_h-HEBl5qoIg. 
2)  Go to the Share option below the uploaded video and select embed. 
3)  Copy the html code presented (<iframe…..</iframe>) 
4)  Log in to your website and select Edit for the page where you wish to upload the video. 
5) Select Source from the editing tools, which will reveal the html code for that page. 
6) Select the location where you wish the video to appear and paste the copied html code. 
7) You will need to ensure the code isn’t re-formatted by a text editor if this is in place. 
8) Remember to Save. 
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Specialist	Sites	

I.	Special	instructions	for	Research	Group	microsites	
 

 

The Communications and Web team have developed a template which is available for the use of 
all research groups. The template incorporates an automatic feed from the departmental database 
for group members and publications, to prevent the need for manual updates. 

You will still need to provide group news and information about your research. It is suggested that 
in addition to the PI, one or two members of the research group are trained to edit the site.  

Instructions on editing the following features are given below: 

1) People - current group members 
2) People - past group members  
3) Research pages 
4) Publications 
5) Adding new pages to your Research Group site 

If your group requires different features, please contact the Communications and Web team, who 
would be pleased to work with you to develop new features.   

1.	People	–	current	group	members		
 
A.		To	populate	your	group	members	page		

1) Go to site admin. 
2) Click on staff page settings. 
3) You will see the default Staff Content options, which will include some or all of these terms: 

• M.Phil 
• Head of group 
• M.Phil student 
• Part III student 
• Support staff 
• Postdoctoral researcher 



Department	of	Chemistry	
Website	Editing	Instructions	

September	2018	
	

 30 

• Research assistant 
• Graduate student 
• Undergraduate student 
• Visitor 
• Staff 

4) Click on the categories you wish to appear on your Group Members page. If the category you 
need does not appear as an option, you can add a customised category name (see next 
instructions).  

5) Save. 

B.	To	add	an	additional	staff	category	

1) Go to Site admin. 
2) Click Staff page settings. 
3) Click on by going here (in the first line under “Staff category ordering”). 

 

4) Click on +Add term. 
5) Create the name of the new staff category. 
6) Insert both the Plural and the non-plural form. 
7) Save.  

C.  To change the hierarchy of staff categories 

You may wish to change the orders in which the categories appear on your staff page.  To do so, 
follow these instructions:  

1) Go to Site admin. 
2) Click on Staff page settings. 
3) Click on by going here (in the first line under “Staff category ordering”). 
4) This takes you to a page called “Staff category.” You can drag and drop the categories 

into any position you wish by putting your cursor on the cross next to the category 
name. 
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5) Always remember to click Save, or your changes will not show up. 

D.	To	manually	change	the	category	of	a	group	member	

1) Go to the “People” page. 
2) Click on the name of the group member whose category you wish to change.   
3) This will bring you to their staff page on your research group site. 
4) Click on the edit tab of the staff page. 
5) Tick the field Custom Staff category. 
6) Go to the Staff category field and start to type the desired staff category; the category 

name will be supplied.  Note: The desired staff category must already exist (if it doesn’t 
exist, see “To add an additional staff category”, page 27, which must be done before this 
step).  

7) Note that this is a manual override of the group member’s designation in the database, and 
you must manually update the category if the staff member leaves the group or their role 
changes (you may also untick Custom staff category and the designation will revert to 
what exists in the database).  

E.		To	add	a	group	member	who	is	external	to	the	department:		

This feature enables you to add people who are external to the department (ie, not on the 
department database or on the University HR system) to your group pages. 

1) Click on Add Content. 
2) Select External staff page.  
3) Start to type in Staff category, and the category will be provided. 
4) Upload a photo, recommended size 150x200 pixels.  
5) Complete the other information requested. 
6) Save.   
7) Note, it may take a little while for the new page to show up on the website. 

F.		To	create	a	custom	current	members	page	
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This allows you to manually create your own custom group members page. If you choose to do 
this, you will need to update regularly to ensure it is accurate. 

1) Go to Site admin.  
2) Click on Staff page settings. 
3) Tick the box marked Custom current members page. 
4) Choose Save configuration. 

2.	People	–	past	group	members		

The past members page is enabled as an automatic feed from the department database.  
However, you can make the following changes. 

A.	To	change	the	title	of	the	past	members	page	

If you prefer to call your page something other than “past members” (eg, “alumni”), take the 
following steps:  

1) Go to Manage content. 
2) Go to Past Members and click edit title. 
3) Type in your desired title. 
4) Be sure to click Save at the bottom of the page. 

B.	To	edit	the	past	members	page		

1) Under the People tab, click on Past Members. 
2) Next to each name, there is an edit link. 
3) Click the edit link to bring you to that person’s information page. 
4) You can change the following information within the page: 

a. Staff category (Check custom staff category, then type in the desired staff 
category (note, this must be a staff category which already exists, see page 27 & 28 
above).  

b. About:  You can add information about the person. 
c. Related links:  Add related links. 
d. Switch physical status:  Tick to change status from current to past, or from past to 

current. 
e. Year start/Year end:  You may change this if you wish, or leave blank 
f. Current email/current URL 

5) Make sure to Save any changes. 

C.		To	create	a	custom	past	members	page	

This feature allows you to manually create a custom past group members page.  If you choose to 
do this, you will need to update regularly to ensure it is accurate. 

1) Go to Site admin.  
2) Click on Staff page settings. 
3) Tick the box marked Custom past members page. 
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4) Choose Save configuration. 

D.	To	disable	the	past	members	page	(so	it	can	no	longer	be	viewed)	

1) Go to manage content. 
2) Find the past members page. 
3) Untick enabled. 
4) The page will no longer be visible. 
5) Be sure to Save the new configuration.  

3.	Research	pages	
 

 

A.		To	create	a	research	page	

You may create research pages which highlight different areas of your group’s research, and 
include the publications of selected group members. For each page, take the following steps: 

1) Go to Add content. 
2) Click Research page. 
3) Insert content as you would for any basic page (see “Adding content to an existing page”, 

page 7).  
4) Notice two features different from a Basic Page:  

a. Related Publications:  Typing in the Publication title field will trigger an auto-
selection feature, offering items from the publication site. Choose the appropriate 
paper(s) and save. 

b. Person reference: The names of all group members appear in this field. Select the 
name/s of the people whose publications you want to see on the page and save. 

5) At the bottom of the page, choose Research as the parent item. 
6) Ensure the Menu link title matches the title that you have given the page. 
7) Save. 

B.		To	change	the	order	of	your	research	pages	in	the	menu	

1) Go to Manage content. 
2) Drag and drop by clicking on the cross icon. 
3) Save. 
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4.	Publications		
 

 

A.		To	change	the	default	publications	feed	from	Symplectic	

By default all publications by the group PI appear on the Publications page as an automatic feed 
from Symplectic. To change the settings (eg, add or delete group members’ publications), take the 
following steps: 

1) Go to Site admin. 
2) Choose Publication settings. 
3) By default the group PI CSRID will appear in the field. You can enter the CSRID of any 

other people whose publications you wish to appear on the publications page. 
4) Alternatively check Show publications for all staff pages to include publications of all 

group members. 
5) Press submit. 

B.		To	add	Selected	Publications	to	a	group	member’s	page	

Each group members’s page contains an automatic publication feed from Symplectic. You can 
choose to add a separate section for Selected Publications.  

1) Go the group member’s page. 
2) Click on Edit. 
3) Scroll down to Selected Publications. 
4) Start typing the publication title, and the title will be auto-completed. 
5) Save. 
6) Selected Publications will show up as a separate heading on the group member’s page.  

C.	To	add	images	to	your	publications	feed	

All publications by members of the department appear on the department website at 
https://www.ch.cam.ac.uk/publications and on individual staff pages and in Group Research 
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microsites.  The website filters the publications via Symplectic, using an algorithm to find an 
appropriate image for most publications. 

If you wish to add or change the image attached to a specific publication, follow these directions: 

1) Go to the publications microsite: https://publications.ch.cam.ac.uk. You must use your 
Raven password to access the site. 

 

 

2) Search for the publication to which you wish to add an image. 
3) Click on the title of the publication. 
4) This takes you to a new page where you can upload the desired image. 

 

 

5) Image size must be below 2Mb. 
6) Please be aware that http://publications.ch.cam.ac.uk is a live site, and changes published 

there will immediately update all department websites. Be very careful when uploading and 
do not experiment in this area. Seek advice and assistance if you are unsure. 

5.	Other	features	of	your	Research	Group	microsite	

1) You may add features such as a Carousel, Teasers and Quick Links to your site (see 
“Home Page Set-up”, page 18).  
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2) You can create additional basic pages (see “Creating a new page”, page 17) and add them 
as menu items to your home page (see “Menu link title”, page 16 and “Manage main menu 
and tabs”, page 21).  
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II.	Committees	microsite	
 
All committee Chairs and Secretaries should have editing rights to the Committees microsite. If 
you think you should have editing rights but cannot access the site, please contact the 
communications team (details below). 
 
In the Committees microsite, will be able to add terms of reference, add/delete committee 
members and their roles, and upload committee papers, including agendas and minutes. 
 
1.	To	access	the	Committees	microsite	
1) Go to the Committees microsite (https://www.ch.cam.ac.uk/committees/). 
2) Click on your committee’s name on the diagram, which brings you to that committee page.  
3) Log in. (Note: Our website has a quirk which means if you were previously logged in to a 
different department microsite and hadn’t logged out, you may have to browse to 
https://www.ch.cam.ac.uk/committees/user/logout, before you are able to log in to the Committees 
site).  
4) You should see tabs at the top of your committee page that say View and Edit.  
5) Click on the Edit tab. 
 
You may now make the following revisions: 
 
2.	Add	terms	of	reference	
1)Type the committee’s terms of reference in the box headed Terms of reference. 

• See “Adding content to an existing page” (page 7) for basic instructions on entering text. 
• Terms of reference should be clear and concise. It is good practice for the terms of 

reference to have no more than 8 points (see Library terms of reference for an example).  
2)Scroll down to the bottom of the page and select Save (or your changes will be lost).  
 
3.	Add/delete	committee	members	
1) Under the Edit tab, scroll down to the section headed Committee Members.  
2) To remove an existing committee member, select Remove and Save. 
3) To change the role of an existing committee member, select their appropriate role from the drop 
down box headed Role under their name. Remember to Save. If the desired role does not exist in 
the dropdown box, please contact the communications team and we will add it. 
4) To add a new Committee member: 

• Select Add another Paragraph.   
• Start typing the committee member’s name in the field headed Member and select the 

correct name when it appears. 
• Select the Role of the new committee member. 
• Save. 

 
4.	RIG	Committee	members:	a	special	case	

• RIG Committee members are taken as an automatic feed from the database. 
• Only secretaries can be manually added to the RIG member list. 
• RIG secretaries are responsible for ensuring that their RIG membership is correct in the 

database. 
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A.	To	add	or	delete	a	RIG	member	in	the	database	
1) Go to the Chemistry database (https://database.ch.private.cam.ac.uk/db-v3/login.php) and log 
in. 
2) Select View>Research Interest Group. 
3) Click on the appropriate RIG. 
4) To add an Associate RIG member 

• Go the field RIG member. 
• Select Others. 
• Find the name you need in the drop down list and click on it. 
• That name is automatically added to the field RIG member. 

5) To add a Core member 
• Go to the field Primary member. 
• Select Others. 
• Click on the name you need in the drop down box and it is automatically added. 
• Note that this drop down box only includes academic members of staff. 

6) To delete a RIG member 
• Go to either field (RIG member or Primary member) and click on the name. 
• It is automatically deleted.  

7) Select update to save your changes. If you have made a mistake, simply navigate away from 
the page and don’t update.  
 
5.	Upload	committee	papers		
A. Upload minutes, agendas and background or other documents, restrict documents so they can 
be seen only by committee members, tag restricted documents as “draft” or “pre-approved.” (See 
B below for replacing draft versions with final versions).  
 
1) Go to Add Content at the top left (grey area) of the committee page. 
2) Select File upload, which takes you to the Create file upload page. 
3) On the Create File upload page, select the File type from the drop down menu. 

• An agenda document is any type of paper, other than the agenda or minutes, that is 
relevant to the next meeting. It will appear with the agenda in the committee’s list of 
agendas.  

• An other document may be any other type of document (eg, a constitution) that is relevant 
to the committee as a whole, but not to a particular meeting.  

4) Select Browse, and choose the file from your computer that you wish to upload.  Files must be 
less than 20MB and must be in txt, doc, docx or pdf format. 
5) Upload the file. 
5) Select your committee from the drop down Committee list. 
6) Select the Meeting date to which the file is relevant. (If no meeting date is selected, the default 
date will be the date the document is uploaded). 
7) Choose the level of Access.   

• Restricted: The file is only visible to committee members. 
• Unrestricted: The file is visible to members of the department who have Raven access.  
• If you have a document that is permitted to be seen by some committee members but not 

by others, please do not upload it here – circulate by email. 
8) If the file is set as Restricted, set the relevant Title tag. 

• Restricted 
• Restricted Draft refers to minutes which have not been approved by the committee. 



Department	of	Chemistry	
Website	Editing	Instructions	

September	2018	
	

 39 

• Restricted Pre-approved: Some committees prefer the term pre-approved to refer to 
minutes which have been reviewed but have not received final approval from the full 
committee. 

• If the File is set as restricted and no Title Tag is set, then on the page the file will simply 
be tagged as restricted. 

9) Remember to Save. 
 
B.  Replace draft or pre-approved minutes with final versions 
1) To prevent several versions of the same Minutes appearing in the Committee documents list, 
go to edit the existing Draft or Pre-approved Minutes, and replace the old file with the final (or 
different) version.  
2) Go to your committee page. 
3) Choose the draft or pre-approved minutes that you wish to change, and click on view node. 
4) Under the heading file, remove the existing file and upload the new version. 
5) Change other headings as needed (eg, restricted to un-restricted). 
6) Save. 
 
6.	Trouble	shooting	
1) I am trying to add a new committee member, but their name doesn’t show up – what do I do? 

• If the person is a member of the department who should be in the department staff 
database, please contact Emma Graham (ejg49@cam.ac.uk) to ensure the person is 
added to the staff database.  Note that once they are added to the database, you may need 
to wait overnight for the system to refresh before the website will pick up their name.  

• If the new member should not be in the department staff database, then you can add them 
to your Committee by selecting Extra Committee Member. Complete all the fields if 
possible:  

o Title = their name (e.g. “Dr John Smith”); Sortable name = Their name expressed in 
a way that makes them easy to locate in a list (e.g. “Smith, John”). 

2) I cannot access the editing pages or the RIG view of the database. 
• Try going to the URL and at the end type: /user/logout.  Then log in again. 
• Try using a different web browser. 
• If neither of these solutions works, contact support@ch.cam.ac.uk and request editing 

access. 
3) I want to add a new RIG member to our RIG committee, but their name doesn’t show up on the 
RIG view in the database. 

• The person must be listed in the database for their name to be visible on the RIG view. 
Contact Emma Graham ejg49@cam.ac.uk to ensure they are added to the database (see 
question 1 above).  

 
If you have any further questions about editing the Committees microsite, please contact a 
member of the Communications and Web Team: 

• Diane Harris, Project Delivery Coordinator: dh473@cam.ac.uk 
• Rachel Gardner, editor Chem@Cam: rg580@cam.ac.uk 
• Carl Hogsden, IT developer: cdh30@cam.ac.uk 

Questions relating to purely technical issues (eg, My computer won’t start! My email doesn’t work!) 
should always be directed to support@ch.cam.ac.uk. 
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